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1. Job Basics

1.1. The Job Concept

What is an Automation Engine Job?

An Automation Engine Job represents an amount of work to be done for a certain order in your
business system. This can be a classic order management system but it could also come from a web
application that needs Automation Engine to execute some prepress tasks.

A Jobisan entry in the Automation Engine Jobs database and has a unique name. In the Pilot, Jobs are
represented by this blue foldericon 3.

In Automation Engine, a Job consists of 2 things:

- Data: Files and folders, stored under the Job's Job Folder, in a Container.

« Metadata: The parameters of that job order, usually how the order management system describes
this job. They can be general parameters like the job's name, order ID, customer and due date but
can also be parameters describing what to do with the input files to get to the targeted result.

Jobs can be created manually by an Automation Engine user or automatically via some integration with
an external system.

A Job represents Work In Progress (WIP). This means that you should remove Jobs that are 'done'.
Removing a Job from the Automation Engine Jobs database does not mean that you have to delete the
related data files.

Note: AE SaaS users can inactivate old Jobs by moving them to Esko Cloud. Learn more in the chapter
on AE SaaS.

Most Automation is based on Jobs

Alot of the automation that Automation Engine brings comes from the fact that tasks can
automatically use parameters from their Job context. Job parameters automatically become
SmartNames and the (workflow) task tickets can use those SmartNames to pick up their values.

Note: Customers that do not use Jobs at all find a similar level of automation by using Workflow
Parameters. Learn more in Using Workflow Parameters.

Launching tasks on Jobs

Jobs can be managed manually in the Pilot, but several actions are also possible by launching tasks.

« The Create Job task task allows to create and modify Jobs.

+ The Check Job Parameters (Classic)task allows to check and correct barcode and ink parameters
used in designs.
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« The Archive Job task and the Restore Job task allow to remove Jobs, store their data on a different
network place and, if needed later, restore them back, including their metadata.

« The Relocate Job task allows to move a Job's Job Folder to a different place. For example to another
Container that has more disk space.
Learn more about these tasks in Tasks you can Launch on Jobs on page 53.

Like all tasks, these tasks can also be triggered by an external system. Learn more in Integrating with
External Systems.

1.2. Types of Jobs

Conceptually, we can distinguish several types of Automation Engine Jobs. This categorisation usually
depends on these factors:

« What type of site are you? Does your company only do prepress or do you also produce? And if you
produce, do you also re-produce items that you produced before?

« Isyour Automation Engine closely integrated with your order management system? If it is, then
Automation Engine best follows a similar process logic as in that system. Terms like jobs, orders,
products, items, milestones etc. will need to have the same meaning.

We distinguish 3 types of Jobs:

Attention: The categorization of these job types does not appear in the user interface of
Automation Engine. Their names are only used here to illustrate different ways of working with
the tools Jobs and Products. Learn more about Products in the chapter Products.

Type 1: A Prepress Job

The goal of a Prepress Job is to make a single one-up design print-ready. Typical steps are preflight,
making print-ready and approval. The result is a file that is ready to be produced.

Some variations:

« The production can then be done in-house (in another Job, under another order number) or the
print-ready file can be sent out to a company that produces.

« Theresulting file can be registered as an Automation Engine Product.

« APrepressJob can result in multiple files, but only when they belong to the same product item, for
example front and back graphics. They probably also share the same approval cycle.

« At(flexo) prepress houses (‘trade-shops'), the result could also be a set of plates.

The Job can be removed when the work is done.

Type 2: A Production Job

A Production Job is a job that uses one or multiple product items for a specific production run. The
product items were already approved and print-ready. The goal of this type of job is output.

A Production Job does not contain the one-up's data in its job folder, but links to one or multiple
Products. The job folder of a Production Job typically only stores the layout files or other data that are
unique to this specific production order. The product data stay in their Product Data Zone.
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The Job can be removed when the work is done. The Products are not removed, they stay 'live' until a
next Job links them in for another production run.

Type 3: An All-In-One Job

Some customers have Jobs in which they handle both the prepress work and the output production.
The one-up datais stored inside the job folder, not registered as a Product and the workflow continues
within this Job with the productions steps(layout, plates, send to press...). Production related datais
also kept inside this job folder.

In some cases, when the output is combined with other (already existing) items, this can mean that the
one-up data is copied from other (older)jobs into in this job folder.

The Job can be removed when the complete work is done.

Attention: In this chapter, we will describe the use of Jobs without the use of the Products
tool.

1.3. The Jobs Views

Note: The view Inactive Jobs'is only available for AE SaaS setups. Learn more in AE SaaS: When your
AE isin a Data Center.

1.3.1. General Job Views

The Pilot and its Views were introduced in The Pilot's Main Window. We here illustrate some job-related
specifics:
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£ Automation Engine Pilot ==l
Fileh 1 View Go Job Tools Advanced Help 2
= |88) & Job ovenview v|&* | O E £ -
= Views Jobs
&5 Jobs Name = Description Due Date Order ID Sub Or...
(54 cor & 000100001 000100001 -
&) Milestones (52 002_barcode 002_barcods
B Smart Views [ 1009_BusinessC... 1009_BusinessC... ;|
o & 1235 L Dec 27, 2014 1235 L
5 FruitCo Jobs B3 1236 4 Oct 11, 2014 1236
£5 Jobs created today & 1237 Dec2, 2014 1237
= Tools (5 1404-L74536_002  New flavour Cocos and lemon Jun 1, 2015 1404-L74536 0oz
@ Devices e 1404-L86203_003  Promo strawberry 100ml south Europe cluster  Jun 1, 2015 1404-L86203
= . () 1404-W7T4536_002 Mew flavour Cocos and lemon _1 Jun 1, 2015 1404-W74536 oo2
Ul Queve Monitor & 1404-W74509_009 New flavour Banana Jun1, 2015 1404-W74592 009
CH containers (53 1404-W86203_003 Fromo strawberry 100ml South Europe_1 Jun 1, 2015 1404-W86203 003
B Access Points 5 5411028040230 5411028040230
I [h G66-97634 G66-97634 %
1% Customers
Job Detalls
A Users
Job Hame: 1404-L86203_003
QOrder 1ID: 1404-L86203 G
SubOrder 1ID: 003
Last Actar: dva (rdvmaedemo) o
preview
Due Date: Jun 1, 2015 10:00:00 AM
Category: flexo
Customer 1D: 123456
Customer Mame: YoghurtXL Company

Job Folder:
Description:

fila://eqsbe100/RND-SW-Sprints-Gent/Automation Engine/Public/dema_container/DVA/1404-LE6203
Promao strawberry 100ml south Europe cluster

1 of 58 selected

Server: ROVMAEDEMO User: wde [F]32 &

1. Type of View.

The = Containers view shows the folder structure of your Containers but will show a folder in
blue when it is an active Job Folder. Double click any blue folder to select and view that job.

The 5= Job Overview shows all jobs (or a filtered list). You can combine this with Smart Views.

* The kJ Last used Job view opens the last used job in the job specific view.
2. Info. This button opens the Job Setup of the selected job. Learn more in Job Setup Parameters on
page 15.
. Search input field. Learn more in Job View Filters on page 8.
Job Overview. Define the columns and their order in View > Select Columns in 'Jobs"....
. Job Details. See some of the job's details. Learn more in Job Setup Parameters on page 15.
Amount of Jobs (selected).

LI S
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Note: When you open the drop-down list, you can select another job that you recently used. You can
set the amount of remembered jobs in Edit > Preferences > Pilot.

P

rents of “file: ) /egsbel00/RD- SW- Sprints-Gent/Autematon Engine/Public/deme_corms Law
o ~ View Type  Size Date ™
Lanana. pof View for... 25.. 11/20/144:3..

G Lo» L Publir | demo_container® | FrultCe® | FrukCo Jobse G2 1236 =
»

[Task Type Progress  Phase State  Lownched
Create PAF [JPG /... 100% B 13/10/14 12:28 FM
Cregte PAF/JPG /... 100% B 1279714 3:57 P
Ciptimize and Clean ... 100% B 121014 12:07 PM
Ep 100% B 1172014 4:20 PM
2] Milest -] LO0% 1720414 4:20 BM
larman mAf ranha Ramark TRas 1N m 1L 400 P

Tip: If you reqularly switch between same views, consider using multiple view tabs (File > New Tab).
For example:

{1 Automation Engine Pilot
File Edit View Go Job Tools Advanced Help

= 38 & [ob overview “ wle £ -

22 Jobs | 14 FruitCo Jobs | 2 Jobs created to.., | [ smartiames (... | £3 Tickets | + |

=l Views Jobs
£ Jobs Name - Description Due Date Order 1D Sub Order 1D
[ cor (o 4682_002 Kiwi Mango - SP (Mexico) Dec 25, 2014 4682 0oz
&) Milestones
= Smart Views
4 FruitCo Jobs
£ Jobs created today
= Toals

1.3.2. Job View Filters

Basic Searching

When you type in a filter in the Search input field, the filter will be looked for in All of the default
attributes Order ID,Name, Project ID,Customer Job Reference.

{=] Automation Engine Pilo

File Edit View Go Job Tools Advanced Help
E|EE|D :JuhO\rerviw v: “"|.|123* . -
£l Views ISearch: All| Order ID Name Project I Customer Job Reference Done | Save +
54 Jobs =
== Jobs
[ cot
() Milestones Name = Description Due Date Order 1D Sub Order 1D
5 Smart Views f&a 1235 banana Dec 27, 2014 1235
e ) I 1236 lemon Oct 11, 2014 1236
L FruitCo Jobs a2 1237 manga super size Dec 2, 2014 1237
= Jobs created today (& 1404-174536_002 New flavour Cocos and lemon Jum 1, 2015 1404-L74536 002
= Tools




ESKO®

Automation Engine

Tip: You can use double quotes to restrict the search. For example:

« FL 123 willlistjobs that have both FL and 123 in at least one attribute.

« "FL 123" willonlylistjobs that have this exact string in at least one attribute.

Click Save to save this search. Decide if it is for all users or only yourself and if you want to add it to
your views bar.

Save As: | all 123 jobs

Scope: () This user only

Options
V| Add to my views bar

Advanced Searching

If you want to search in other attributes, or if you want to create advanced search criteria, click on the +
button. A new search criterion appears.

See how the attributes drop-down list offers many more attributes:

{1 Automation Engine Pilot
File Edit View Go Job Tools Advanced Help
S |88 &3 Job Overview x| @t | @ s X -
= Views Search: |Alll Order ID Name Project ID Customer Job Reference |Hide Criteria | Done  Save |-/
[%%] —_
i Jobs |3ob order 1D *| contains * ()
Job order ID
[ cor
) Milestones Name .
= Smart Views Project 1D Description Due Date Order ID Sub Order ID
£ all 123 jobs Customer job reference banana Dec 27, 2014 1235
= Due date lemon Oct 11, 2014 1236
ti FruitCo Jobs ’
— Created date mango super size Dec 2, 2014 1237
5 Jobs created today  (jgp description Hew flavour Cocos and lemon Jun 1, 2015 1404-L74536 002
= Tools Last actor pemy_12345
[3] pevices Job 1D
E Queue Monitor Job sub order 1D
3 containers Other...

In the drop-down list, select Other... to add even more attributes to this list. For example Customer
name.

Use the + button to continue adding search criteria. For example:
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|~ =
2 Asomaton engine P N o ol 6 o=
File Edit View Go Job Tools Advanced Help
= BB |50 [JobOverview ~ e | £

=] Views Search: |All| Order I Name Project ID Customer Job Reference [Hide Criteria |Done |Savel -
£ Jobs Customer name ~ contains * | fruitco | =]+
CI?I Category = contains = |fexo SIS
S Due date ~ is hefore v  Dec 28, 2014 :e] | ==

= smart Views
E2 FruitCo Jobs s
U4 Jobs created today  1lame < Description Customner Name  Due Date Order ID Sub Order 1D

= Toaols & 1235 banana FruitCo Dec 27, 2014 1235
[ vevices ) 1236 lemon FruitCo Oct 11, 2014 1236

You can even add 'logical operators'to your criterion. Hold Alt when clicking on the + to start your
criterion with All, Any or None. See this example where you are not sure which CSR handles this job

order:
- )
{=] Automation Engine Pilot
File Edit View Go Job Tools Advanced Help
= | B2| G0 [Job Overview - e | o
El Views Search: All| Order ID Name Project ID Customer Job Reference |Hide Criteria | Done |Save || -|
— 25
L5 Jobs Customer name = contains = |fruitco [[=1[+]
C[.)II Category = contains = | flexo = | E |E|
=] Milestanes Due date = Is before = |Dec2d, 2014 9 =)
=l Smart Views .
. Any ~ of the following are true =1[#]
=5 FruitCo Jobs con riins = [Fal | =10+
= contains * =]+
54 Jobs created today L= —
CSR* contzins *  Chantal [[=1[+]
=l Tools

Click Hide Criteria to hide the lines with the criteria but still have them active.

As shown above, you can save the (set of) search criteria. You can re-use it later as a Smart View or pick
it from the drop-down list in the search field:

Sl P
Find Ctri+F

L, Recent Filters

FruitCo Jobs

Clear Recent Filters

Other...

1.3.3. Job Specific View

When you select a job from the drop-down list of last used jobs, or when you double click a blue job
folder, the view adapts and focuses on that job.

« The Pilot top bar mentions the name of the selected job.
« TheLast Used Job drop-down list mentions the name of the job folder.

10
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« The Folders pane shows the (blue)job folder, its subfolders and their files.

« The Tasks pane shows the tasks that were launched in this job context.
- Thelist of favorite tickets also shows (blue) job tickets (saved for this job only).

|File Edit View Go Job Task Tools Advanced Help |

= 8|0 1236 x| | 8| @ @ P~
= Views “  Folders ontents of *file://egsbe -SW-Sprints-Gent/Automation Engine/Publi Launch Favorites
Vi Fald Contents of "file://eqgsbe100/RND-SW-Sprints-Gent/A| tion Engine/Publi Launch Favorite:
[ Files = ?-1nuﬁeslgn Hame = View  Type Size Date Check Trap Proof Flat... =
To Do List % . Proofs ] pdf Vi Normalized..  259KB 11/20/14 4:39 PM £ Flatbed Urgent
i | Pages + | Repaort Files
.ﬁ < ; e 3 IPG Max 1000pix wide
94 Products & ). RIP data
£ Proofs = B S v L Jidemo » ) FrultCor ) FruitCo Jobs* (G2 1236 -
'-'1 WebCenter Tasks *
=
il Flates File Name Task Type Frogress  Fhase State  Launched
anang. Create PAF [ JPG /XML ... 100% ks 12/10/14 12:28 PM
3 cot b pdf fIPG | B 1z
. banana_report.pdf Create PAF [ JPG / XML... 100% B 12/9/14 3:57 PM
[ Gang Run Pri... L jopon oo Optimize and Clean (FS... 100% 11/21/14 12:07 FM
|'_-ﬁ Tasks banana.pdf.banana_report.pdf  Zip 100%: 11/20/14 4:20 FM
£ Milestones lemon.pdf,lemon_report.pdf  Zip 100% B 11/20/14 4:20 PM
[ 1 Smartttam lemaon. pdf Create Report (ReportM... 100% 11/20/14 4:20 FM
mariiames banana.pdf Create Report (ReportM... 100% B 11/20/14 4:20 PM
[ Tickets leman.pdf Optimize and Clean (PS... 100% M 11/20/14 4:20 FM
~ Smart Views hanana. pdf Optimize and Clean (PS... 100% B 11/20/14 4:20 PM
[] Find = banana.pdf, lemon. pdf Workflow 100%: M 11/20/14 4:20 PM
1 of 1 files selectad Server: ROVMAEDEMO  User: wde 3 A

All tasks that are launched in this view will run "in this job". Job based SmartNames will now get their
values from this job.

1.4. The Job Menu

Note: When nojob is selected, some of the menu options are unavailable.

« NewJob.... Learn more in Creating a Job on page 13.
+ GotoJob. When ajobis selected in alist, use this to go to that job (‘open’ the job).
« Job Setup.... This opens the Job Setup dialog of the selected job.

« Find Job.... This opens a separate dialog to search for jobs. Learn more in Job View Filters on page
8.

- Relocate Job. This moves the job folder of a(live)job. Select the ticket of the Relocate Job task.
Learn more in Tasks you can Launch on Jobs on page 53.

+  Remove Job.... This removes the open or selected job(s) from the jobs database. You will be asked
to confirm and you can choose to keep the files and folders. Learn more about removing multiple

jobs and re-creating them in About Removing Jobs on page 50.

« Sharing..., Synchronize Job , Synchronize All Jobs: These relate to functionality described in the
chapter Collaborating via Esko Cloud.

n
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« Delete View Data.... This deletes all View Data present in the job folder. View data are stored in
hidden subfolders of files that were prepared for viewing in the Automation Engine Viewer. You will
be asked to confirm. You can choose to Also unmark subfolders that are marked for Speed for
Viewing. Learn more about this feature and View Data in Prepare for Viewer Task.

« Manage Job Filters.... This opens a dedicated dialog to manage job filters. Learn more in Job View
Filters on page 8.

12
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2. Creatinga Job

You can create jobs manually or they can be created automatically.

Creating a Job Manually

To create ajob, you can first select an existing folder that will become the job folder, or you can have a
new job folder created while you create the job. Follow these steps:

1. Inthe Pilot, choose one of these methods to create a new job:

« GotodJob>New Job...

« Right-click (on an existing folder) and select New Job...

* click the Create Job icon &il*

« (Select afolder and)use Ctrl + Alt + N (Windows)or Cmd + Alt + N (Mac).

2. Inthe New Job dialog, decide if you want to use an existing job as a template.

« Ifyoudon'tuse atemplate, click OK and fill in all the parameters in the next dialog.

« If youwant to use an existing job as a template, select it and decide which type of parameters
you want to include from that job in your new job. Then click OK.

5] New Job &
V] Usz an existing job as a template
Choose Job: | FruitCo Flexible
Include: [ | Files
| Folders
[+#] Tickets
.._f Milestones
| Parameters
V| Inks
ok || cancal |

The job you use as a template could be ajob that is similar to the new one (for example the 123-
lemon job has many same attributes as the 234-banana job). It could also be ajob that you
specifically created to be used as a template (the typical 'flexibles' job for example).

The status, actions and confirmation dates of the milestones in the template job will not be
added to the new job. Their due dates will be relative to the creation date of the new job. For
example: you want the new job to also get the milestone 'proof ready'?2 days after it was
created.

3. Adialog opens with the job setup. Now you can fill in all the parameters for the job.

If you started from an existing folder or used a template, several parameters will already be filled in.

13
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Job | customer | Inks | parameters | Bar Codes | stepaRepeat | categorization | Advanced | Automation | Page Assignment | Imposition|

Order 1D SubOrder ID: |

Job Name:

Mo file selected. Description:

Project 10 |

Category: [ - Categories...
Printing Press: [ - Manage...
Substrate: [ - Manage...

-

Last Actor: [wde

Select the Job folder where the Job's data will be placed and handled:

| ] Use the Smart Job Location Rules as set in Configure Tool. Show Job Location

Erowse

Apply Job Setup... | ok || concel |

Learn more in Job Setup Parameters on page 15.

Creating Jobs Automatically

In most cases, the Automation Engine Job originates in another system. Recreating that job manually
in the Pilot is not an efficient way of working. It is strongly advised to integrate Automation Engine with
that other system and so have the jobs come in automatically. This will both win you time and reduce

errors.

This integration can be based on an incoming file that describes the job or could be a bi-directional
link with that external system. In both cases, the Create Job task will create the Job in background
(probably as part of a workflow task). Such an automated workflow can also update Jobs with new or

changed parameters.

Learn more in Integrating with External Systems.

14
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3. Job Setup Parameters

You can fill in the job setup parameters while creating a job, or, when you are in a job context, by going
to Job > Job Setup....

In an existing job, you can add or modify parameters at any time, except the Order ID and SubOrder ID.
Learn more in Job tab on page 15.

The parameters are spread over multiple tab sheets. The tab sheets Automation, Page Assignment
and Imposition only appear when you are using the module for page workflows.

Most job parameters are automatically offered as Job SmartNames. Learn more in SmartNames.

The button Apply Job Setup... allows to copy parameters from other jobs. Select the job and define
which type of parameters you want to include from that job.

{21 Apply Setup ﬁ
Choose Job: Iﬂ]
Include: ::l Files
Folders
|¥] Tickets
:ﬂ Milestones
|| Parameters
[¥] Inks
r [ categories
| |
ok || concel |

This is similar to how you can use a template job at the moment of job creation. Learn more in Creating
a Job on page 13.

3.1. Job tab

The Job tab contains the main job order information:

15
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Job | Cusmmer| Inks[ Farameters| Bar cndes| Step&Repeat| Cateqorization | Ad\rannedl hummatlon| Page Assignment | Imposition

Order 1D:
Job Name: 1245_001

Mo file selected. Description: |

Due Date:

1245 | SubOrder 1D: 001

lemon flavar
Japanese market

lanz1, 2005 «[12:30PM -

Project ID: |
Category: [fieo -
Printing Press: |Gallus ECS 340 > [ wmanage.. |
Substrate: | > [ manage.. |
Last Actor: | Thomas -
Select the Job folder where the Job's data will be placed and handled:
Use the Smart Jab Location Rules as set in Configure Tool. Show Job Location
file://aezerverdl/demo_containerfFruitCo/FrultCo Jobs/1245_001 Browse |

Apply Job Setup... ]

Thumbnail: When there is no thumbnail yet, it will automatically be set when one of these tasks
finishes successfully in this job context: Normalize PDF File (Classic), Normalize PostScript / PDF /
lllustrator 8.0 File (Classic), or Export ArtPro to Normalized PDF File (Classic).

To set the thumbnail manually, right-click the field and select a file (that has a thumbnail embedded).

Order ID: Order management systems typically define a job order by an identification number. Thisis a

mandatory field.

Important: You can not change it once the job is created.

SubOrder ID: A job order often also has a sub number (or text). You can leave this field blank.

Important: You can not change it once the job is created.

Important: An Automation Engine Job needs to be unique. More specifically, the combination of
Order ID and Suborder ID needs to be unique.

Job Name: This is the name that you see in the job overview mode. This is a mandatory field. If you do
not enter a name here, the name will be "OrderID SubOrderID".

Important: Also the name of the job needs to be unique.

Note: You can change the name of a job after the job was created.

Note: The job name will also be proposed as name for the job folder. Learn more below.
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Description: A short text describing the job order. By using its SmartName version, this text can for
example also be picked up in a report PDF.

Due Date: The due date and time for this job order. This date is used in job filtering and also in several
tasks that allow choosing the Job Due Date as one of the choices for the task due date. For example
the Submit to Gang Run (Classic) task and the Publish on WebCenter task.

Project ID: The identification number of the project that this job order belongs to. Project numbers are
typically defined by the order management system or any other external system. This parameter can be
useful to find jobs that belong to a same project. This parameter can match to a project on WebCenter.

Category: Choose a category from the list. Categories are often used to help you find jobs or to define
the route of a workflow. Click the button Categories... to add new categories manually or by loading a
list from an XML file.

Note: The format of the XML is for this use not specific. Most important to know is that only the values
will be loaded to become category names, not the element names. An example:

[ £ Category éj

<?xml version="1.0"7>

E<List> eI —
<namel>Flexo</namel> :
<name2>Flexo combo</name?> EE::I L
<name3>Digital</name3> Flexo combo i Load... |

L</List>

You can add more custom categories. Two are offered in this tab sheet: Custom Field 1and Custom
Field 2. You can set four more in the tab Categorization. You can configure their custom names in
Configure > Jobs > Job Setup. See an example in the above screenshot.

Tip: In the page about the tab Categorization, you can find a table with matching names of categories,
custom fields and their SmartName versions.

Last Actor: The last Automation Engine user that worked with this Job (launched a task, opened a file).
This is filled in automatically but you can set it manually too.

Job Folder: Define the path of the job folder for this job. You can choose one of these methods:

« Browse to an existing folder (somewhere in one of your containers).

Browse to the root of where you want to create the new job folder and click B. By default, the Job
Name will proposed as name for the job folder. You can change that if you want to.

« Use the Smart Job Location defined in the Configure tool: When selected, the location and name
of the job folder will be calculated based on a job parameter or on the default location for that
customer. A preview of the folder's location and name can be asked by clicking the Show Job
Location button. Learn more in Smart Job Location.

Tip: The Browse button can also be used to relocate an existing job folder. When you here change
the path of an existing job folder, you will be asked if you want to move or copy the data to the new job
folder.

17
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3.2. Customer tab

Customer ID: Click Select... to open the Select Customers dialog. Choose one or add a new customer.
Learn more about creating customers in Customers.

Customer Name and Customer Description: These fields will be filled out automatically after selecting
a customer.

Customer’s Job Reference: This is the term that your customer uses to refer to that job, how they
named it (initially). When communicating with your customer, he will appreciate if you mention this
name (as well). You can for example add this name as a SmartName to a report PDF or add it to a name
of a file that you send him.

Customer Service Representative (CSR): Select or type the name of the person in your sales or service
department who manages this customer account.

The E-mail address of the CSR that you selected is automatically displayed if it was used before. You
can also enter the E-mail address manually.

You can click the Contact... button to open an E-mail message with that E-mail address in the To field
(if an E-mail client is configured).

Tip: All these parameters

« can be used to filter or search for a job.
« canbe entered via XML/JDF/JMF. It is strongly advised not to re-enter these admin data manually.
Learn more on how this can be done in Integrating with External Systems.

« exist as System SmartNames.

3.3. Inks tab

18

This tab allows to store ink specifications for this job.
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'E‘ Job Setup . e : lﬁ‘

|an | Customer| Inks | Farameters | Bar Codes| 5Lep&Repeat| Cateqorization | Advanced | Automation| Fage Aggignment| ]mposltion|

Inks in the following order: Prefarred Ink Book: | BANTGNE+ Soiid Coated Rd
Ink Hame | Ink Book | Ruling | Angle | Dot Shape | Ink Type | Frinting Methed l
M Cyan process 95 Ipi 7e Normal Flexo
W Magenta process 95 Ipi 37e Normal Flexo
Yellow process 95 Ipi gas Nermal Flexo
W Black process 95 Ipi 67 @ Normal Flexo
FANTONE 123 € PANTONE+ Solid Coated 95 Ipi 7o Normal Flexo
. die designer 95 Ipi Technical Other
> gold designer 95 Ipi Opague Screen
I

Default values, used when a ruling, angle or dotshape is not specified:
Ruling: 120 Ipi Angle: |37 ° Dotshape:

[%] 1 there are inks specified in the list, but no default values are set, factory selttings will be used for ruling (120 Ipi) and angle
(459).

o ] (o) |

What you enter here serves as a minimal requirement for this job. This means that you can for example
only enter the angles for a specific set of ink names and leave all other fields or columns blank.

As with most tab sheets, you can enter this data manually, copy these parameters from another job
(see the button Apply Job Setup...) or, when using the Create Job, get them from an XML file.

Use cases

Job ink parameters can be used in these cases:

- When you import design files, the task Normalize PostScript / PDF / lilustrator 8.0 File (Classic) offers
to enforce these job ink parameters in the output file.

« InPackEdge or ArtPro, when you open a file that is located in a job folder, the editor will check if the
file's inks match the job ink parameters and show a warning when they don't. You can also use the
Load Job Parameters feature in the editor's Inks dialog to enforce the job ink parameters.

«  When you use the task Check Job Parameters (Classic), you can check and or modify the attributes
of the inks in the file.

« In page workflows, when you use the Variant Setup in the Imposition tab, the job's inks will be used.

Important: When working with ArtPro+and PDF+(PDF native)files (where no normalization is done),
there is no equivalent for these features.

Note: Ajob can only have one set of ink parameters.

Preferred Ink Book: When you then type an ink name in the table, Automation Engine first searches
thisink in your preferred ink book. For example, if you type 154 as ink name, and your preferred

ink book is Pantone Colors Uncoated, Automation Engine will automatically suggest the ink
PANTONE 154 Uncoated.

Printing Method: You can set a printing method per ink. The list shows those defined in the Configure
tool.

These are typical examples of how to make use of a Printing Method:
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In your Imaging Engine (RIP) task for a flexo device, you select only the inks of printing method
flexo'.

« You make a special ReportMaker PDF that focusses on the 'ink' used for embossing. In your
workflow, you use the Extract Inks (Classic)task to select the wanted ink type before you start the
ReportMaker (Classic) task.

Some tips on editing the ink list
« Tostart, clickin the empty canvas under the column Ink Name and type in an ink name. For example
‘C.
« Ruling uses the unit as defined in Edit > Preferences... > Units.

« Tochange all fields in a column with a same value, double click the column header (valid for Ruling,
Angle or Dot Shape).

« You can define specify ruling, angle and dot shape per ink name or you can set Default values by
using the fields at the bottom of the tab sheet to specify them for all such fields (when still empty).

3.4. Parameters tab

This tab allows to store two types of job parameters:

« General custom job parameters, with a name and value that you decide. They will also appear as a
SmartName.

« FlexRip/Proof tasks parameters. This is an older technology that allows enforcing job parameters
into the FlexRip or FlexProof task tickets. Learn more in FlexRip/Proof Job Parameters on page
22.

Note: With Imaging Engine, this concept is replaced by the use of SmartNames.

These job parameters can be created in 3 ways:
« Manually. Learn more in Creating and Modifying a Custom Job Parameter on page 20.

« Byloading values from an XML file. Learn more in Loading Job Parameters from an XML File on page
21.

« By using the Create Job task, where you use the (XML) input from an external system. Learn more in
Create Job.

3.4.1. Creating and Modifying a Custom Job Parameter

Use the buttons Add..., Modify... and Remove to manage your custom parameters manually.
Follow these steps to add a custom job parameter:

1. Click Add... to open the Add Job Parameter dialog.

2. Choose the Scope 'General'. Learn more about the other Scopes in FlexRip/Proof Job Parameters on
page 22.
3. Typeinthe Name and Value and click OK.

The SmartName version will be created automatically. To easily recognize which SmartNames are job
specific, their name starts with [jp. 1.
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3.4.2. Loading Job Parameters from an XML File

If you have an XML file that contains the custom job parameters, you can create them automatically by

loading them into your job setup:

This XML requires this basic structure ; within a root node, a simple list of pairs of elements and their

value:

<root>
<parameterl>xxx</parameterl>
<parameter2>yyy</parameter2>
</root>

An example:

<jobparams>
<profile>CMYK</profile>
<proofing>e-mail</proofing>
<reportcard>yes</reportcard>
</Jjobparams>

1. Inthe Job Setup tab Parameters, click Load....
2. Inthe Load Job Parameters from XML dialog, click Browse and browse to your XML file.

3. Click OK. You now have a custom parameter for all value pairs the XML contains from the root node.
All elements and their values will be imported.
An example result after loading such an XML file:

oee SR e

Il
Joh Parameters B-arcn-desl step&Repeal| Cateqorization | Impasition | Amnmaunn' Fage Asaignmem| Advanced

|
| P
Il | | scope Name value

General Description Shrek Promo South America

General Design file://aeserverl1/Fublic/Design Arrival/Shrek, pdf

General FTPFolder ToyDreamFTF

General JobType Display

General FreFlightProfile CMYK Digplay

General PreFlightyesio yes

General ReportCardyesho yes

General SendViaFTPorEMAIL Email

Add Modify Remove Load...
Apply Job Setup... | ok || cancsl

Tip: If you have long parameter lists, you can use the search field to help you filter them. The value

is checked in Scope, Name and Value.

Job parameters also become SmartNames. See the automatically created SmartNames of these

custom job parameters (for this job '1236'):

21



E S KD a Automation Engine

i =
£} Automation Engine Pilot (Job: “1236") 2=l A X
File Edit View Go Job Tools Advanced Help i
2 &[0 12 | [P F O O i %+
] Views Search: [all] Name Tags Scope Type Category Description Done |Sawve ||
[ Files |
* To Do Ligt Hame - Type Category Scope Include Smartiames From:
i) Pages jp.Description System Job Parameters  Global [ A workflove:
9 jp.Design Systarm Job Parameters  Glabal =l
{2 Products ip.FTRFolder System  Job Parameters  Global L — |
[ Proofs jp.JobType System  Job Parameters  Global [T & product part:
@ WebCenter Jp.FreFlightProfile System Job Parameters  Global Browe
- jp.PreFlightyesio System Job Parameters  Global
[ Fiotes jp.ReportCardyesho Systern  Job Parameters  Global Resolve all using:
E.] D1 ip.SendviaFTPorEMAIL Systam Job Parameters  Global D Atk
[ Gang Run Frinting . sk )

Learn more about using SmartNames in SmartNames.

3.4.3. FlexRip/Proof Job Parameters

Note: With Imaging Engine, this concept is replaced by the use of SmartNames.

Creating Job Parameters for FlexRip or FlexProof

1. Click Add... to open the Add Job Parameter dialog.
2. Choose the Scope of a specific task type of FlexRip or FlexProof.
3. Check the parameters that you want to enforce during RIP'ing and define their value. For example:
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[ Job Setup

[ = |

Farameters | gar Codes | StepaRapeat | Cateqorization | Advanced | Automation | Page Assignment | imposition|

Scope Mame
RIF to CDI Compact LEN File

=group of names>

Value

£] Modify Job Parameter X

|| Scope: |RIF to CDI Compact LEN File

MName

8

Shrink Values from File
| Distortion v (%)

Distartion H (%)

Scale V (%)

97.8

0= ]

Scale H (26)

100

Rotate (* COW)
Marks

o

<Nana>

Single Curve

EG_FIQ2taibump.dgc

Automatic

<None>

]

Right Reading

No

Positive

Yes

Screening Type

Esko Classic (Precalculated)

)

Daotshape

s

-

[ ok || cancel

Add...

Apply Job Setup...

oK ][ Cancel

Click OK. The job parameters for this type of FlexRip/Proof will be added as one line.

Using Job Parameters for FlexRip or FlexProof

When you now select a file in that job and open a task ticket for that particular FlexRip/Proof, you
will see fields that are marked by an orange icon . These are fields that are overruled by the job

parameters.

For example:
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Settings for Step: RIF to CDI Compact LEN File

- B Device: | CDI Compact ¥ FlexRipC -> CDI Compact 4232 Q Var
4
General | Inks | Advanced | Fre-rip | output
Transformations Original Size {ind.Margins) Qutput Size (ind.Margins)
Seale v: M 078 Size V: 56.652mm Size V: 94,5257 mm
Size H: 95.1832mm Size H: 95.1832mm
Scale H: 100 %o
. . Marks
Rotate: 0 ¥ o5
. ’ SmartMarks: n -

Shrink: | Use values from file Screening
Type: | Esko Classic (Highline for C, E, R, 5) -

Dotshape: I cs (Circular Samba)

Dot Gain Compensation
Single Curve: [ EG_FIQ2tolbump.dgc
Automatic: -

Flatemaking DGC: Mo platemaking DGC is spedified in configuration confl

3.5. Barcodes tab

24

In the Barcodes tab you can create parameters for multiple barcodes of different types.

Tip: One file can for example have a retail barcode and also a general purpose barcode that will be
used for a filling station.

As with most tab sheets, you can enter this data manually or get them from an XML file when using the
Create Job.

Tip: When selecting a barcode, the specified parameters are shown in the Details area.

Similar to the Inks tab on page 18, these parameters can be used to enforce their parameters

into the barcodes of the job files that you opened in PackEdge or ArtPro. Also here, the Check Job
Parameter task can be used to check or correct the barcodes in the files versus the parameters you
specify here.

See this example where the job parameters are enforced Hinto the barcode in PackEdge:
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In AE Job Setup In PackEdge
Bcoce ML 00 @
Type: [i_EAN-lB - Bar Code | Box ]
Sub Type: - Type: o EAN 13 |
Code: |5449000111654 Orientation: . & = @l
Composite Code: |
= (0,000 _|:|
Output Resolution: | 2340 | Code: £1 5449000111654
Bar Width Reduction: 0.2 Bar Width Reduciion: = 0,200
geticalnyansataL : Device Compensation: (0,000 _lj
Narrow Bar: . .
Magnification: 124242
Magnification: |1.25
Height )
. | eigl 15,000
Quiput Resclution: [ 2540 CEm
W Add Charactars
W Light Margin Indicator
ok | cancel | Apply |

See this example where the job parameters are enforced into the barcode in ArtPro+:

2. ArtPro+
Open file from this AE Job
Create Barcode

R D I B O

ean Select FRocolor Shaper Barcode Sereening  Trapping

|I'H WT

S 4 %’i‘ﬁmﬁ.

1. Automation Engine

Job Setup g

O Modity Barcode

Type: EAN-13
swhee:|
Code: | 400141385851
Composite Code:

We now briefly describe the available parameters. We refer to the documentation of your Esko editor for
more details.
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Type

Selecting a Type is mandatory.

Note: When you define more than one barcode, the checking mechanism with the editors and the
Check Job Parameter (Classic) task will recognize the type of barcode and check accordingly.

Sub Type

Some barcode types offer sub types. For example a Data matrix code.

Code

The validity of the code is not checked here in this dialog. This is done in the editors.

Composite Code

A Composite Code is a 2D symbol placed on top of a GS1barcode, that encodes extra information
(batch number, expiration date...).

Output Resolution

Enter the resolution (in ppi) that you will use to RIP your barcode. This parameter helps preventing
unwanted levels of rounding in the bar width. )

Bar Width Reduction (BWR)

Use this parameter to adjust the width of the barcode bars, in order to compensate for ink bleeding
when printing on your substrate.

Your printer or customer will usually provide you with the value to use. For example if your printer tells
you that the line width will increase by 0.01 mm, you should use a Bar Width Reduction value of 0.01
mm.

Important: This field expects a value in millimeters (mm).

Important: If you use a comma as a decimal symbol, it will be replaced by a dot.

Tip: You can enter a negative value if you want to print thicker and not thinner bars.

Device Compensation

Use this if your printer gave you a separate device bleed value. This parameter adjusts the bar's width
to compensate for bleed caused by the plate or film making process.

Important: This field expects a value in millimeters (mm).

Note: If you use both a Bar Width Reduction and a Device Compensation value, the software will add
them together to adjust the bar's width.
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Tip: You can enter a negative value if you want to print thicker and not thinner bars.

Narrow Bar
This parameter determines the width of the narrowest bar of your barcode (and affects the width of

your barcode proportionally). For GS1barcodes, this affects the size (height and width) of your barcode
proportionally.

Magnification

Use this parameter to increase or decrease the barcode size proportionally. For example: enter 1.25
for a magnification of 125%.

Important: The value needs to be between 80% and 200%.

Ratio
The Ratio is the factor between the width of the narrowest bar and the width of the widest bar in your

barcode. For example, enter 3 if you want your widest bar to be three times as wide as your narrowest
bar.

3.6. Step & Repeat tab

Specific JDF

This tab with Step & Repeat parameters is only useful in a workflow where you receive a JOF from an
external system that describes the Step & Repeat via “JDF for Stripping for Packaging”. Such a JDF will
not only create the job but also store those specific Step & Repeat parameters in this tab.

These parameters also become job parameter SmartNames and can so be picked up by Step & Repeat
tasks. They willappearas [jp.steprepeat. ].

Note: The task Import JDF Step & Repeat (Classic) uses the JDF itself as input. In that case the values
shown here are just informational and the task does not use SmartNames.

Also via XML?
Step & Repeat specifications can also come from external systems via an XML file or database queries

or HTTP calls. In such cases, these parameters do not end up in this tab sheet and they also become
other types of SmartNames. Learn more about this in Integrating with External Systems.

Manual entry

You can also enter values manually here but that usage is not different than when you would add them
in the custom Parameters tab sheet.
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3.7. Categorization tab

1 Attention: This tab only appears if you created custom categories in the Configure tool(learn
A more below).

The Categorization tab allows you to manage up to four extra custom Job Categories (you already have
three category fields in the Job tab).

You can use these custom categories as extra ways to search jobs. And you can also use their
SmartNames in task tickets.

Creating and Modifying a Custom Category

Go to Tools > Configure > Jobs > Job Setup and type the name of custom category.

Managing their Values
To manage the list of values you can choose for each category, click the corresponding Manage...

button, and add or remove items to the list. In this dialog, you can also load lists of items from an XML
file by clicking Load....

Overview of Custom Categories and their SmartNames

Because there is already 1standard Job Category, the number of your custom categories will be 1
higher. See this overview:

Table: Names of custom Categories

3.8. Advanced tab

Name of Job setup tab Name of category in Custom field number  Name of SmartName
Job setup

Job "Category" / Job Category

Job name you gave custom field 1 Job Category 2

Job name you gave custom field 2 Job Category 3
Categorization name you gave custom field 3 Job Category 4
Categorization name you gave custom field 4 Job Category b
Categorization name you gave custom field 5 Job Category 6
Categorization name you gave custom field 6 Job Category 7

28

This tab sheet offers a feature to automatically start a task or workflow when you create or update a

job that uses this job as a template.
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Important: Thisis an old feature. Learn below about alternative ways to reach the same goal.

If you wish to use this, check the toggle and select the Task Type and Ticket Name.

When is a Job updated?

Ajob is updated in these cases:

+  When the JDF that created the job is sent again to Automation Engine. Learn more about JOF in
Integrating with External Systems.

« When a Create Job task is launched again on the same job.

When is this feature useful?

This feature can be useful when you have jobs that are created automatically via JOF without the
automatic launching of tasks at that moment. Your JDF can then specify that a job needs to be used as
atemplate. And that template job can have this parameter active to launch a task.

Alternative methods

There are other ways to launch a workflow in a job that was just created or updated.

The task Create Job

« can be part of a workflow, so right after this step where the job is created your workflow continues
with more steps.
« can be started automatically by an Access Point. Learn more in Access Points.

« also has atab sheet with this same feature. Learn more in Create Job.

3.9. Sharing tab

3.10.

This tab shows information about the sharing of files in this job with other Automation Engine servers
within your company.

Learn more in the chapter Collaborating via Esko Cloud.

Automation tab (Page workflow)

Note: This tab is only offered in page workflows. Learn about these classic tools in the dedicated AE
Commercial Print manual available for Automation Engine version 18.1or older.

The Automation tab offers tools to automate your page workflow. When a certain job related event
happens, a specific task can be launched automatically, which then can lead to a next status in the
workflow.

You can do this for Normalization, Proofing and Exposing.
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] Job Setup ﬁ

[an| Customer | lnlts| Parameters | Bar codes| Step&Repeat | Categorization | Advanced | Automation | Fage Asgignment[ Imposition|

¥hen the following happens, Automation Engine can launch tasks automaticalky:

] wh is delivered, lize weith:
Ll €N @ page 15 delivered, normalize wi [ Seledt Task... ]

i_{ Page Normalization WFL (Workflow)

7| When | & sheet side - is complete, proof with:
-

1| Default (Export Imposition to POF File)

| i , ith:
| When |a plate > is ready, expose with Salect Task...

i} Plate qutput weorkflow (Workflow)

| Apply Job Setup... [ oK | cancel |

« Choose how you want to normalize the file when a page is delivered. Select a single task ticket or a
workflow ticket.

« Choose when you want to launch a proofing output task: when a sheet side, a variant or an
imposition is complete. Select a task ticket.

« Choose when to expose your job: when a plate, a separation set or an imposition is ready
(complete and approved if required). Select a single task ticket or a workflow ticket.

3.11. Page Assignment tab (Page workflow)

Note: This tab is only offered in page workflows. Learn about these classic tools in the dedicated AE
Commercial Print manual available for Automation Engine version 18.1or older.

This tab offers settings to automate the assigning of incoming PDF files to Page slots.

3.12. Imposition tab (Page workflow)

Note: This tab is only offered in page workflows. Learn about these classic tools in the dedicated AE
Commercial Print manual available for Automation Engine version 18.1or older.

« Variant Setup

When working with variants, this allows you to select the correct use case and variant separation
from the list. Learn more in the AE Commercial Print manual, in "Working with Plates' # 'Variant
Setup'.

« Output prerequisites
These settings allow you to decide when a separation can be considered as being ready.

«  When no page is rejected: This is called "implicit approval". The plate status in the Plates View
will indicate 'ready for ripping'if all the pages of the plate are assigned and if no page is rejected.
When a page for that plate is unassigned or rejected, the output task on a plate will fail.
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When all pages are approved: This is called "explicit approval”, it is more strict than "implicit
approval". The plate status in the Plates View will only indicate 'ready for ripping' if all the pages

of the plate are approved. When not all the pages on that plate are approved, the output task on
a plate will fail.

Learn more in the page on 'Task status information'.

Learn more about the Plates tool in the section ‘Working with Plates' of the above mentioned user
manual.
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4. About Job Folder Location

4.1. General Note on Data Structure

32

Automation Engine allows you to choose your own data structure

As mentioned in the page Containers (an Introduction), Automation Engine will work with the data
structure you have.

Note: In an AE SaaS setup, the AE Containers are not inside your LAN network. Learn more in the
chapter AE SaaS: When your AE is in a Data Center.

This freedom also brings requests for advice on what data structure would best serve your specific
needs. The more you learn about the available tools (Jobs, Products, SmartNames, Workflow
Parameters, etc.) the more you will learn what is(no longer)important in that data structure.

Historical View on Data Structure

Before there were workflow automation servers like Automation Engine, prepress managers built up
their own logic in the prepress data structure. Prepress operators browsed many folders in the network
to openafile in their workstation editor and then saved it again, often with a changed name.

Very typical was the habit to write information about the files into both their name and their location.
For example: a final version was named "name final.pdf" orwritteninafolder "Final™". Orafile
wasnamed "lemon ¢ m y k pmsl123.pdf".0Orwhenthejob wasready to be archived they moved

the whole job folder to ashare "For Archive".

Then came workflow automation servers like Automation Engine where the information is
(automatically) stored in database fields. And the user can see information via a dedicated interface
inan AE client. You can for example list all jobs of the category "NON-FOOD" or you canuse the "i"
button to see the PDF's inks (XMP metadata).

Does this mean that the data structure and the file naming is less important than before? No, actually
the opposite is true.

Why is it still Advised to have a Logical Data Structure?

There are two main reasons why a logical data structure is more important than ever:
« For the people that do not use the Pilot or a browser workspace.
Are there non-prepress users looking directly at your prepress data structure? If those people are

not using an AE client, they will still want to get information from the location or from the name (like
in the ‘'old days)).

Note: We advise to check if those colleagues will not prefer to use an AE client and benefit from
that information-rich view. Remember you can use User Access Rights to limit heir access. And
they could even benefit from using the Viewer.
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« For external systems that look at, use or deliver the data.

What other systems are looking at your data structure or at files that come from there? What
systems send you data into that data structure?

The integration of Automation Engine with many other systems is the main reason that your data
more than ever needs to be well structured and named. Learn more in Integrating with External
Systems.

For these reasons we advise to:

« Investigate thoroughly what data structure will serve your needs and those of the system(s) you
(will)integrate with. This includes avoiding copied data.

« Useallthe tools that can automate the creation of those folders and file names (templates,
SmartNames, Smart Job Location etc.).

4.2. FAQs on Job Folder Location

Can | Move a Job Folder?

As explained in The Job Concept on page 4, ajob is a temporary object. But even during its short life
time, it can happen that you want to move the physical data to another place in the network.

In this case, it is very important that you use one of the tools in Automation Engine to do this. If you use
the 0S tools (Windows Explorer, Mac Finder etc.), Automation Engine will not be aware of this move and
its database field for the job folder will still refer to the old path.

You can relocate a job folder

- manually, one by one. By using the browse button in the Job tab on page 15 of the job setup. You will
have the choice to move or copy the folder.

- by using the Relocate Job task. You can launch this task on multiple jobs (for example on a smart
filtered selection).

Can | Rename a Job Folder?
To rename ajob folder you can use the same manual relocation tool as mentioned above.

1. Inthe Job tab of the job setup, in the field with the job folder path, change the name of the folder.
2. Click OK. The resulting dialog offers a choice on what to do with the original folder and files.
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Relocate the job ﬂ

S — e —

I h Instead of the original jobfolder:
file:/faeserverdl/Food/FruitCo/FruitCo Jobs/1236
anather folder will be usad:
file://aeserverll/Food/FruitCo/FruitCo Jobs/1236_NewName
What should be done with the original falder and its files?
@ Wove the files to the new jobfoider, the original jobfolder will be removed

Copy the files to the new jobfolder.

0K [ Cancel

3. Make your choice and click OK.

What happens when | Remove a Job Folder from a live Job ?

When Automation Engine can not access the job folder of ajob that you are trying to open or use, a
warning dialog will mention "Could not retrieve the list of files". The Pilot will show the job folder in
yellow.

This is the same warning that you will get when there is network problem and Automation Engine can
for example not access a complete Container.

When Automation Engine can again access that folder again, with the place and name it was expecting,
the job folder will again be shown in blue and ready for use.

Note: In the Configure tool, there is a feature that allows to remove all "dangling jobs" (jobs that have no
more link to their job folder). Learn more here.

4.3. Good Practices regarding Job Folder Location
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Creating all your job folders under 1 same root folder can result in a slow Automation Engine Pilot and
even slow tasks. We advise not to do this.

Here is an example setup that certainly causes too many subfolders in one same folder:

;1 i; Iobs _| LN 3N CASESs HMArTames can De used.

-4 Job Setup | Customers | Rules | Container |

-3 JOF Sehp

p-# Job Web Page Containgr: [PCcontaingr -
Al-4% Newus Folder: | [Order 10 Brause | []
il 1% Nofification
1|3 Odystar

To keep your system healthy, it is good practice to use subfolders in your data structure.

Here is some advise on what logic you could use to decide that data structure:

About using Subfolders per Customer Name

We do not advise this, mainly because customers tend to change their names. It looks like a good idea
at first, but Esko has seen many customers migrating away from this structure.
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About using Subfolders per Customer ID

We do not advise this. It is true that using a customer ID is more stable, but it also has some
disadvantages:

« That customer ID number is often meaningless to the Esko users.

« Because legal regulations may require your company to keep track of order history, it is possible
that old customers may not be deleted in the business system. That is why, when your customer
changes his name, some business systems then change the ID anyway.

« Another reason to not base your folders on customer ID is that customer companies also merge.

These reasons show that we again face the same issues as when we use the customer's name.

About Using Subfolders per Type of Job Order
We do advise to base a data structure on types of jobs.
If you have prepress orders(creating and getting a one-up print ready) and production orders

(outputting existing approved data), then structure them in separate folders or even different
Containers.

Or you can use the product or production type: labels, carton, digital, flexo, offset etc. A typical way to
set this up is by using the SmartName of a Job (custom) Category.

About Using Subfolders per Order Range

We do advise to create a data structure where you split folders based on the job's Order ID.

For example: all jobs in the 1000 range in one folder, all jobs in the 2000 range in the next folder, etc.
This is a straight forward structure that will not allow more than 1000 subfolders in one folder. Use
String Extract SmartNames to set this up.

This is considered to be the best practice.

For example:

T o L L T I ]

3% Jobs | Customers | Rules Contaner
4k Job Setup
## IOF Sehup Container: | PCoontainer =
3 lob Web Page Felder: [Labels/TFirst 2 digits OrdesiD]000-[First 2 digits OrderID]998/[Order Io]| %Me [1
- e GO0 s s o

-3 Nexus

T MakReakas

Note: All these principles also apply to folders where you store Products (Product Data Zone). Learn
more in the dedicated chapter on Products.
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5. Uploading Files to Jobs

There are many ways to upload files to a job folder's folder structure:
» Manually:
« usingthe Pilot

- dragand drop files or folders from outside the Pilot onto a job (sub)folder in the Pilot. Or use
copy/paste shortcuts.

« right-click a job (sub)folder and choose Upload Files.... Learn more here.
« right-click ajob (sub)folder and choose Upload Files from FTP Site.... Learn more here.
- using My Workspace (browser client). Learn more in Workspace 'My Workspace'.

» using Shuttle, as start of a workflow in this job. Learn more in Working with Shuttle.

« Automatically:

- from Access Points. Any of the 5 types of Access Points can upload data to a job (sub)folder (and
launch a workflow). The Folder Access Point can also be a subfolder of the job folder. Learn more
in Integrating with External Systems.

« using the Download WebCenter Document task. When your Automation Engine is connected
to a WebCenter, this task logs on to WebCenter and downloads documents from a specified
WebCenter project. Learn more in Integrating with WebCenter.

« from WebCenter,

« by synchronizing the WebCenter project with an Automation Engine job. When a WebCenter
project has a workflow connection with an Automation Engine job, documents can be
copied to that job when synchronizing. Set this up in the Configure page of the WebCenter
project.

« by using WebCenter's Sync Workflow task in a WebCenter workflow. Learn more in the
WebCenter documentation.
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6. Milestones: Tracking Job Status

6.1. Concept

Milestones represent important moments in the life of an Automation Engine job. Each job has at least
one Milestone: the moment it was created. You can add Milestones, predefined ones or custom ones.
Each Milestone has a due date and several other attributes (see below). The goal of a Milestone is that
is gets confirmed.

Note: The Job Due Date that you set in the job setup is not automatically created as a Milestone.

A Milestone has these attributes:

aName. For example "Approved".

a Due Date. This is the time that this Milestone is expected to be confirmed. It could represent when
deliverables are expected (plates, print production, shipping, invoicing). Or it could stand for the
time an action is expected to be finished, for example "Approved"in 3 days.

a status. Users can decide on the status Confirmed or not (still "pending").

a set of Actions. You can optionally attach Actions that need to be done to get that Milestone
confirmed.

a Responsible user.

Milestones can be created and managed

manually, by a user in the Pilot.
by copying them from a template job (manually or via the Create Job).

by the Manage Milestone task.

by an external system, using JDF/JMF. Learn more in Integrating with External Systems.

How can you Use Job Milestones?

Milestones can be used

as the basis for status feedback to external systems. This is the main reason to invest in setting up
and using Milestones.

Automation Engine focuses on reporting what happens with a job but not on job organization

or job distribution: that is the task of the order management system. What is important is that
Automation Engine reports back to such systems and that this ideally happens without manual
intervention of prepress users (who have other things to focus on). Learn more in Informing Other
Systems of the Milestones Statuses on page 49.

in the Pilot,

« when filtering jobs. For example you want to remove all jobs that have a milestone "Finished"
confirmed more than 2 weeks ago.

- asvisual help when tracking the status of jobs.
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6.2. The Milestones View

This view is different when you are using it in the Job Overview mode or in the Last Used Job mode.

Both these views use these icons for different milestone statuses:

#indicates the time the job was created.
« 4 indicates the current time on the time line.

Cindicates a pending milestone (not confirmed).
[Z] indicates a selected milestone.

iy
Cindicates an overdue milestone: the current time is later than the due date of the (pending)
milestone.

T indicates a milestone that contains one or more Actions that are not all completed. Learn more
in Working with Milestone Actions on page 44.

Clindicates a pending milestone of which all Actions are completed.

(s,

indicates a confirmed milestone. A milestone must be completed before it can be confirmed.

6.2.1. In Job Overview Mode

When you are in Job Overview mode, you can see all milestones of a(filtered)list of jobs.

The Milestones view offers two types of overview.

The Timeline View

The Timeline ViewEl shows you the milestones for a defined period.

0 momaonirgnerior TN W adsise ol

File Edit View Go Job Milestones Tools Advanced Help

= BE[ [sb Overview @t EEREEE B B
Wiews Jobs
# J0bs 15 January 2015 L6 January 2005 L7 January 2015 18 January 2015 19 January 2015 20 January 2015 21 January 2015
Thu Fri Sat Sun Man Tue wed
3 coe @
] Milestores & 1235 g
= Smat Views
Tl 8l 12 jobs G 1236 3
thl all 123 jobs
L FrunCo Jobs =Rz B
= Jobs created today
) all 12 jobs m 8 [ 2 2 9
Toals -
1] Devices e ¥ ] @ g a
g eyt @ue 3 ] o o o
4 Access Paints
ife Custamers
£ Users Mibestane Details

Nama: Files arimid
Actians: 172 Finishad
Job: 1340
4 Duse Date: Jan 16, 2015 12:20:00 PM

] check FTF site (Pending)
) eall CSR {Frnighed)

1 of 6 szlectad Server: RDVMAEDEMO  User: wde =15
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Use these buttons to define the time period you are viewing:

week.

From the menu Milestones, use Go to Date... to specify a specific date in the center of your view.

Select a milestone to see Milestone Details in the bottom pane.

Tip: When hovering over a milestone icon, you will see its name and more details:

15)an 15 16Jan 15 17 Jan 15 18 Jan 15 19 Jan 15 |20 Jen 15 21 Jan 15 22 Jan 15

Thi - Fri Sat Sun Man Tue Wed Thii
& 1240 ” & a o-‘-N o] 8
9 1241 ¥ B & | Milestone Mame: Proofs ready
P ! p Job Name: 1240
Dhuse Date: Jan 18, 2015 12:21:00 PM

Tip: Double click a milestone icon to open the milestone view for that specific job.

The Status View

The Status View BB shows the milestones and their status in columns.

&1 Automation Engine Pilot
File Edit View Go Job Milestones Tools Advanced Help

2 BE[E [2obOverview e EE e E | E X
= Views Jobs
22 Jabs Hame Filas armived Froofs ready Approved Flates ready
T3 cor
= Milestones & 125 o
= Smart Views
B &2 123 ]
B2 all 12 jobs -
= )
o all 123 jobs By
-
il FruitCa Jabs
£ Jobs created today 3 1240 H B = &}
1 all 12 jobs
= Toals [=RFo] 5 5] a =
11 pevices
8 Queve Monitor 5 1242 b o = ™
3 Containers Milestanes
T acoass Peinis Miestane fame Fnished Actions Confirmed Due Date Respansibie
Tk Customers Flles arrved 1z Ho Jan 16, 2015 12:20:00 PM _wde
L users Proafs ready oo Ha Jan 18, 2015 12:21:00 PM wie
Approved oo Ha Jen 20, 2015 12:21:00 PM  we
| Platos ready oo He Jan 21, 2015 12:22:00 PM wde
Agtions
what Stata Due Date
| check FTP site FPending Jan 16, 2015 1:30:00 AM
W ol oS8 Completed Jan 16, 2015 3:00:00 &M

1 of 6 szlectad Server: RDVMAEDEMD  User: wde =15

Go to View > Select Columns... to choose which milestones will be shown here and to define the order

of these columns.
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If noicon appears in a milestone column, this means that this milestone is not defined for that job.

6.2.2. In Job Mode

In Last Used Job mode, the Milestones view shows all the milestones for a specific job.

{=] Automation Engine Pilot (Job: “1241")

File Edit View Go Job Milestones Tools Advanced Help
= 88| [1241 ~ || e

= Views *  milestone Name Finished Actions  Confirmed Due Date Responsible
|:| Files Files arrived 242 Jan 15, 2015 3:40:44 PM_ Jan 16, 2015 1:31:00 AM wie
To Do List Proofs ready a0 Jan 15, 2015 3:32:35 PM  Jan 18, 2015 1:32:00 AM wide
i Pages Approved o/ No Jan 20, 2015 1:32:00 AM wide
= Flates ready 0/0 No Jan 21, 2015 1:33:00 AM wile
414 Products
@Pmﬂfs 3 151 2015 (18] 2015 (171 2015 18 ) 2015 19 2015 (201 2015 (211) 2015

anuary anuary anuary anuary anuary anuary anuary

WebCenter Thu Fri Sat Sun Mon Tue Wed
48] Plates ¥
43 cor i@ $ g §
[ cang Run Frinting - e
5 oss HNEEEE
) Milestones what State Due Date
L1 smartiames |¥| check FTF server Completed Jan 16, 2015 1:30:00 AM
7 Tickets |¥] Preflight before edit Completed Jan 16, 2015 1:30:00 AM

= Smart Views
[ ] Find o

1 of 4 selectad Server: ROVMAEDEMO  User: wde 5

Select a milestone to see it selected in the time line and to see details below about any actions for this
milestone.

Printing out the Job's Milestones

You can use Milestones > Print Milestones... to print (or save to PDF)a view of a job's milestones. You
can define the printer's page format but the content of the page is fixed. The page shows some major
job info and the milestones' timeline and overview.

An example:
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@ Milestones 42100 Scope label

Job Hame: 42100 Soope label
Due Date Age 20, 2004 43000 FA
Oirdes |0 42100
SusiDrder ID: 0000 0000004
Categary: Senps jobs
Customer Weionlng
Customar Raterancs: B 4E6E004
Lasd Aetor: e pade
Folder file:# e geodede dedataS cope_jobs 2900 _Scope_Label
Dapcrption; Seope Binoculars abel (European elease end 2004
TimeLine
apr zz 23 24 25 26 27 28 3 20 apr
v e w o &

e B B ] =

=
I e N 3
Shart

Ape 22, 2004 34604

b PM

] Files ol atle fuEti (agede) 0610 - Confirmed ‘;‘: 23, 2004 45000

] edingin BEE ardl wde (e gude) 10t 1 . Confirmed mm. 200470000
[3] edting toda :;24. 3004 S20:00

= Approvd digltaly admin (apads) 0610 - Confirmed :s 29, 2004 230,00

3 Plates Ready george (egwde) 0 of 0 - Corfirmed m 29, 2004 10:00:0

& Emon no swrer 0 o0 - Mot Confitmed @ :‘: 30, 2004 420:00

Note: The thumbnail of the job shown in this printout is the one you can (manually) add in the Job tab
sheet of the job setup.

6.3. Adding Milestones to aJob

Adding a Milestone Manually

1. Select yourjob and open the Milestones view.

2. Click &1*, or o to File > New Milestone.

Milestone Hame: [ Approved

Description:

Due Date: |Jan 23,2015 v |2:00 &M

Reminder: m 20
| -]

Responsibla: [Ehlls.ﬁaron Praslay

3. From the Milestone Name list, select the milestone you want to add to this job. If the one you want
is not yet in the list, click Manage... and create it there. Learn more in Manage (Custom) Milestones
on page 42.

4. |f youwant, add a Description for your milestone.

5. Define a Due Date and time. This is a mandatory field.
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6. If youwant, add a Reminder. Choose an absolute time or a time relative to the due date. At that
time, areminder will be E-mailed to the Responsible user.

7. Select the user that is Responsible for this milestone. This is a mandatory field when you set a
reminder.

8. Click OK.

Copying the Milestones from another Job

When you create a new job (manually or via the Create Job task or via JDOF), you can copy the properties
of another job (template) to that new job. This can include the milestones of that other job.

=] New Job ﬁ
[¥] Use an existing job as a template
Choose Job: | FruitCo Label template [ Select... |
Include: [| | Files
Z Folders
| Tickets
] Milestones:
| Farameterd
| Inks
ok || cancel

The copied milestones will be set relative to the creation date and time of the new job.

For example, a typical job for your customer 'FruitCo' has a job due date of 9 days after job creation
and during that period it includes 3 custom milestones. The due date of the new job that copies those
milestones will then be set to 9 days after its creation date. And its milestones will be created relative
to the new creation date.

6.4. Manage (Custom) Milestones

There are many predefined milestones, but you can also create custom milestones.
In the Milestones view (in Last Used Job mode):

1. Go to Milestones > Manage Milestones. This dialog shows you all your milestones and their
attributes:

42



ESKO®

Automation Engine

Name =

Approved
AwaitingApproval
Files arrived
Imposition complete

Impasition proafs ready

Job archived
Job finished
Job printed

Job shipped

Fage proofs approved
Fage proofs ready
Page proofs rejected
Fages ready

Flates ready
PostPress done
PrePress done

Proofs ready

Froofs sent

Ready for platemaking

Imposition proofs approved

JDF Imported Job activated

Hickname Comments

Approval cycle started on WebCenter E Fublished from AE

Custorner OK

Prepress can start with PreFlight

OK from Admin Departmient to Print

Use as Product Status
v

~
il
~

Add l Remaove

2. Click the Add button.

In this dialog:

Hame: |Apprwal cycle started on WebCenter
Nickname: |

Color: [ Choose... H Clear ]

Tcon: Browse... Clear

Comments: | Fublished from AE

[] This can be used as Froduct Status

« Enter a Name for your custom milestone.

« You can also enter a Nickname, this is the name that will be shown in the Pilot interface. This
is also useful when your milestones are managed by JOF/JMF. Learn more in Integrating with

External Systems.

« If youwant, choose a Color and / or browse to an lcon to help recognize this milestone. Icons can
be based on JPEG/PNG/GIF files and will be automatically scaled to a fitting resolution.

« You can also enter Comments. For example to explain all users how this milestone should be

used or if an external system is using this milestone information.

« If you use the Products tool, define if this milestone can also be used as Products status.
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« Click OK. Your custom milestone now appears in the list and is ready to be added to jobs..

Note: You can safely remove milestones that you already used in jobs. Those jobs will not loose their
(local copy) of the milestone.

6.5. Working with Milestone Actions

44

Concept

A milestone represents a status that you want to reach. A milestone can also list what Actions need
to be done to reach that state. A milestone can only be confirmed when all its actions were set to
completed.

Some customers use these tools extensively and ask their users to base their daily work on the
milestone actions appearing in their To Do List. These users then use custom filters when over-viewing
(their) actions. They typically filter their actions based on user, state and urgency.

Creating Milestone Actions

To add an action to a milestone:
1. Select the milestone in the Milestones view.

Click E1* or go to Milestones > New Action... or right-click on the canvas in the bottom part of the
Pilot.

3. Inthe New Action dialog, enter what needs to be done, who needs to do it and by when.

[ 5] New Action ﬁ1

Subject: | Check CAD file

To: wde v:
Jab: 1241
Milestone: Flles arrived
Due Date: |On »|Jan 16,2015 w|1:31 AM -
state; Pending

Meseage: Download it from webcCenter.
If any questions, ask Diana or Robert.

ok || cancel

The user that needs to do the action can later change the State from Pending to In Progress,
Completed or Aborted.

Working with Milestone Actions

Milestone actions appear

« inthe Milestone view, when in job mode. See a screen shot here.
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« inthe To Do List, as Milestone Actions. The To Do list offers some more functionality on these

actions:

[ Automation Engine Pilot (lob: “12417)

File Edit View Go Job Tools Advanced Help
= 88| 120 = BT | E° | A YkReleaser @ | £

= Views = ictions
L] Files Subject » To State Job Type Due Date
[ To Do Lst {1 check FTF server ehis Fending 1241 Milesione Action 1/16/15 1:30 AM
(L] Poges ght before edit I Prograss = i CLi0n 1/16/15 1:30 AM
£ products Ne'w.ﬂﬁpn...
[ Procfs = Datails Open Action..
=1 wishCentar ) Forward... -
B . Lam currently handling this ta do item
g'::ﬁ Release To L
[ Gang Run Printing Subject: Preflght bafore edit Delate
5 Tasks From: wide
- Date: Jan 15, 2015 3:37:13 FM ; =
) Milestones T N:e d Show in Tasks View
L] smarthames Due Date: Jan 16, 2015 1:30:00 AM
7 Tickets Milestone: Fies arrived

= Smart Views Mess2ge:
L1 Find i Files: 0
P

Server: ROVMAEDEMD  User: wie  [F16

Right-click to open, delete or create a new action.

Right-click or click *& to Forward the action to another user.

Check 'l am currently handling this item' to change the state to In progress.

Open (double-click) the action to use these extra tools:

{=] Open Action "Preflight before edit”

Subject:  Preflight before edit

Ta: wide Fram: wide

Job: 1241 Received: Jan 15, 2015 3:37:13 PM

Milestone: DigitalartArrived

Due Date:  On > Jan 16, 2015 w 1:30 AM

' quite some prablems in this file, mostiy font related,
nathing we can't solve ourselves,

« Change the State.

Note: Because the names of these states are shared with CheckPoint Actions, choosing Accept or
Reject will for a milestone action result in Done.

« Change the Due Date.

« AddaMessage.

For example: a user opens his to do list in the morning and uses a filter showing all the actions on
his name that have a due date before noon, in the state Pending or In Progress. He can also use the

column due date to sort by urgency.
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6.6. Using Milestone Statuses to Filter Jobs

The filters that you make in Job Overview mode can also be based on milestones.

See this example of a filter that was saved as a Smart View named"Still Need Plates Today" It

only shows jobs with an unconfirmed milestone "Plates Ready" that has a due date today:

& Automtion Engine Pilot. - CEEE ==
File Edit View Go Job Tools Advanced Help
= 28] [1oboverview ~ | e P-
Views *  Search: |All] Order ID Hame Project I Customer Job Reference Hide Criteria |Done | Sawe||=
i
£ Jabs Exigts = & ribestong where Sl=
-
:'! e Milestane name = i Plates ready =
£ Milestones All v of the following are true
= smart Views e
- Milastone due date = 15 todey = =
25 a1l 123 jobs =
- - o =
55 Eruneo Jobs Milestone state > IS F m @ |
12 Jobs created today Jabs
il Still Heed Pates Today Hame » Desesiption Customer Mame  Due Date Order 1D ForWhichOperator
) 2ll 12 Jobs i3 1404-L74536_002  New flavoar Cocos and leman  YoghurfXL Jun 1, 2015 1404-L 74536 Adam
Toals (&3 1404-WF4536_002 Cocos and Banana Yogqhurtel Jun 1, 2013 1404-WT4336 Ay User.. 2
7 Devices 308 Detalls
2 Queue Monitor

= rontainers

2 jobs Server: RDVMAEDEMO  Useriwde =8 A

Learn more on creating such filters in Job View Filters on page 8.

6.7. Using Milestones in Workflows: the Manage Milestone
Task

Concept

Using milestones in workflows enables these principles:

« Milestones can help control a workflow. A workflow can check the status of a milestone before
continuing (in a specific direction). Use the workflow control Router to do this. See an example
here. Learn more in Router.

Tip: When you also work with the Products tool, then check if the dedicated Wait for Product
Status task is a better alternative.

- The Manage Milestone task helps to automate working with milestones. This task serves to create

and confirm milestones as a workflow step. This enables a lot of automation when working with
milestones. And you can also use it to hold workflows. Learn more below.

See an example of a workflow that automatically confirms four milestones:
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The Manage Milestone Task

You can use this task to automatically decide one or multiple of these milestone attributes:

£ Edit Ticket of Manage Milestone _ X

E

a

Set all pending actions of the following milestone in state "Completed™: l 0K from Admin Department to Print i =
Z Create the milestone if it does not exist
|+ | Automatically confirm the milestone

© [Gamraa] & o) e |

. Set all pending actions of the following milestone in state "Completed": Select the milestone you
want to set as "Completed”. Learn more about Milestone Actions in Working with Milestone Actions.
This setting is mandatory.

« Create the milestone if it does not exist: If the above selected milestone you selected was not
yet added to the job, check this option to add it (otherwise the task will fail). The milestone will be
created with the status "Completed".

« Automatically confirm the milestone:

« Checkthis option to set the above selected milestone as "Confirmed" and have the workflow
continue with its next step(s) or with any task that was waiting for this milestone to be
confirmed.

« Do not check this option if you are still waiting for a confirmation. The task will then serve as a
hold-point: it will pause the workflow until that milestone is confirmed.

+ Inthe Workflow Editor, this step then will jump up and down, as a signal that a user
intervention is needed:

ol 56 1 intervention nesded
. . &

@@= g ® =0 P [(E) O=p [ G
o &l : lamnaitend v/

Starl Cne Up WFL Manage Milesione SlepiRepeal Make Plate an O
WFL col

Right-click the file-icon and choose to Open Milestone... or to Show in Tasks View.

+ Inthe Tasks view, you will see the phase User intervention needed.
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File Name Task Type Frogress  Phase State
banana.pdf Manage Milestone 0% User intervention needed [x ]
banana.pdf Warkflow 100%
banana.pdf Workflow 0% Running (]

Click on the red text to open the milestone dialog where you can change any setting.

Open Milestone "PrePress dcne_"__ g

Milestone Hame: ' FrePress done

Deseription:

Due Date: [Jan 22, 2015 | 2:43PM

[7] Reminder: [other...

| - |

Respansible: [ Thomas

If you check Confirm Milestone (and click OK), the workflow will continue. If you can not
confirm this milestone yourself but for example need the help of someone else, then typein a
description and change the responsible user.

« Inthe Milestones view, right-click to open the milestone or directly click in the column
Confirmed to change it to Yes.

Milestone Name Finished Actions Confirmed Due Date Respansible

FrePress done oo | Jan 22, 2015 2:43:00 PM toto
Mo
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Tip: Some customers make the manual confirmation of a milestone easy by offering the users a
favorite ticket that only (creates and) confirms a milestone. This is useful when that user is aware of a
status that Automation Engine has no information on.

For example: A plate room operator checks plates that come out of the developer. He reads their
job number on the plate and types it in as a job filter in his simplified Pilot. He then launches the
appropriate favorite ticket: Plates OK or Plates NOT OK.

- . "
[] Automation Engine Pilot (Job: *1237") FEE ST e
File Edit View Go Job Task Tools Advanced Help

= 8|0 2 x| a5t At 0 o -
= Views Folders Contents of "file://egsbal00/RND-SW-Sprints-Gent/Automation Engindl Launch Favorites X
L] Files _.@SV Mame » View Type S... Date 2 Plates NOT OK -
[t cor = | Bxort 5 Plates OK .
+ Tools - files
4 Layout
+ | Proofs
£ RIPoutput @ S (v Ji» Jlcr () FruitCo® )i FruitCo Jobs* G 1237 ~
Tasks x
File Name Task Type Ticket Name Frogress  Phase State  Launched
1237 Manage Milestone Plates NOT QK 1009 B 1/22/15 3:58 PM
1 of 1 tasks selected Server: ROVMAEDEMO  User: elvis  [F] 1

This information can now automatically change a workflow and/or be sent out to the system that does
the press planning. Learn more about such feedback in the next section.

6.8. Informing Other Systems of the Milestones Statuses

The milestone status of an Automation Engine job is often more important to external people than to
users of the Pilot. Many parties want to be kept up to date about the latest status in prepress, both
colleagues and customers.

External systems are not always interested in all prepress details. You can choose to only inform them
on some specific milestones.

These are tools that help inform other systems and their users:

- Add a notification to your Manage Milestone task. This can be an E-mail notification or the same
message can also be written in an XML file for an external system to read. Learn more about the
type and content of such messages in Task Notifications.

« Oryoucan use one of many tools dedicated to help integrate Automation Engine with external
systems. Typical methods are
« write out XML files
« write directly in the database of the external system

« whenthe external system is capable of subscribing to JMF signals, you can set up the automatic
sending of JMF signals when a milestone is confirmed.

For more information on these feedback tools, see the dedicated chapter Integrating with External
Systems.
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7. About Removing Jobs

50

Concept

An Automation Engine job represents a Work In Progress. It is expected that you remove the job when
the work is done.

Removing a job means that it is removed from the Automation Engine jobs database. You have the
option to keep the job folder data.

When you remove a job,

« allfinished tasks in that job will be deleted. If you wish to keep those tasks, use the Task Cleanup
Rules to move them (earlier) to the Task History tool.

« if thatjob still has unfinished tasks, you will be asked before removing the job to confirm that they
can be cancelled and deleted.

- all Actions for that job in the To Do List will be deleted.

« any setup of (the old tool) Hot Folders in that job folder will be removed.

« whenyou choose to not delete the job folder, all the job's setup parameters will be stored ina
subfolder 'config'(this is the information that was inside the database).

« thejob will disappear from the Job Overview in the Pilot or workspace.

« inthe Containers view, the blue colored folder icon will turn back into a standard yellow folder icon.

- Thatis now a folder from where you could re-create that job later (using the data in the hidden
‘config folder).

Note: The Archive Job task allows to remove the job (from the database)and move the job folder to a
different place in the network. Learn more in The Archive Job Task on page 54.

You also have tools to reactivate the job, to recreate it back into the jobs database. Learn more below.

Manual and Automatic ways to Remove Jobs

You can remove jobs

« manually, using the Pilot. Learn more below.

» by use of a workflow. This is usually a combination of the Select Job workflow control followed by
the Remove Job task. Use the links to learn more.

. fully automatic, by having an external system launch a workflow that removes jobs. Also JDF can
remove jobs directly. Learn more in the chapter Integrating with External Systems.

Note: In an AE SaaS setup, you can also inactivate Jobs by moving them to Esko Cloud. Learn more in
AE SaaS: When your AE is in a Data Center.

Removing a Single Job

To remove a single job, select the job and press Delete. You can also right-click (or go to the menu Job)
and choose Remove Job....

You will be asked to confirm. You can choose to also remove the job folder and its contents.
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o> .
@I Are you sure you want to remaove the job "6739"7
The setup of Hot Folders in the job will be lost!

|| Blso remove files and folderg

o ][ Cconesl | i

ﬁ Caution: There is no way to Undo the removal of the files and folders.

Removing Multiple Jobs

In the Job Overview mode, you can select multiple jobs and remove them in the same way as described
above. You will also get the option to keep or remove (all) their job folder data.

Note: Itis good practice to use a smart filter when you select multiple jobs to be deleted. For example:
all jobs that have their milestone finished' confirmed more than a month ago.

Note: There is no "Remove Job" task, so you can not remove jobs as a workflow step.

In Edit > Preferences, you can decide to avoid getting (many) questions when you remove multiple
jobs:

« questions about jobs being in use by other users. A job is 'in use' when a user has this job open in his
Pilot.

« questions about jobs containing unfinished tasks.

@ oo N

| Tickets | units | Files | Pilot]

To avoid questions during Multi-Job Removal, certain checks can be ignored:

|:| Remove Jobs even when they are in use by other users

[' | Remove Jobs even when they contain unfinished tasks

Learn more in Pilot Preferences on Multi Job Removal.

Recreating a Job that was Removed
When a job was removed but the job folder data is still available, you can recreate that job back into the
jobs database.
There are two ways to recreate a job:
« Recreating ajob manually. Follow these steps:

1. InContainers view, select the yellow folder that used to be the job folder of a removed job.
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Folders

= 1. FruitCo

(= .. FruitCo Jobs
(i) 666-07634
ﬁ 1235
ﬁ 1237
ﬁ 1240

o 1241

ﬁ 1242

[#- 1. 1245_001
ﬁ 4682

2. Right-click(or go to the menu Job) and choose New Job.... When a previous job setup is
detected in that job folder (in the subfolder 'config'), you will be able to recreate that job. Choose
to Reuse the previous setup.

Are you sure you want to recreate job "12417%7

This folder was previously used as a job folder.

3. Click Recreate. The renewed job will be opened and will contain the previous job setup
parameters, subfolders and local (blue)job tickets.

« Recreating one or multiple jobs with the Restore Job task.

Learn more in The Restore Job Task on page 56.

52



ESKO

Automation Engine

8. Tasks you can Launch on Jobs

These are the tasks that you can launch only on Automation Engine jobs:

- The Relocate Job task moves the job folder of a job to another place (within an AE Container).

« The Archive Job task removes a job and exports all its data and metadata into a ZIP file.

« The Restore Job task re-creates ajob from a ZIP file that was created by the Archive Job task.

« The Check Job Parameters (Classic) task checks or correct the input file's barcode and inks
according its job parameters.

« The Remove Job task is used to remove jobs as a step in a workflow. This task is then preceded by
the Select Job workflow control.

« Onlyinan AE SaaS setup, several tasks enable to move Jobs to Esko Cloud, where they become
inactive jobs. Learn more in the chapter AE SaaS: When your AE is in a Data Center.

Like all tasks, these tasks can also be triggered by an external system. Learn more in Integrating with
External Systems.

The Create Job task is documented in the chapter Integrating with External Systems.

8.1. The Relocate Job Task

Concept

This task allows to change the location of an Automation Engine job. The job itself does not change,
only the path of its job folder.

Restriction: You can not launch this task as part of a workflow.

Task Options

FD? Default - Relocate Job B EN = |5 &J

File View Advanced

[2]

a

Neve Job Location: | file://aesarver0l/Food/FruitCo/FruitCo Jobs/[Jab Name] Browse | []

What would you like to do with the files in the original job folder?
Copy the files to the new job location

©) Mave the files to the new job locatior

Don't copy or move the files

Flease note that moving & job to another lacation might cause paths in tickets ta become
obsolete.

#® | Show Steps Save Cancel |

« Enter the New Job Location. Keep in mind to end the location with the name of the job folder.
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« Youcanchoose to:

« Copy thefiles to the new location.
« Move the files from the original job folder to the new one.
« Not copy or move the files. The relocated job will then have an empty job folder.

Warning: If you move a job folder without using a tool from Automation Engine, the job setup
field for the job folder will not be updated and the Pilot will show warnings. Automation Engine
will keep trying to retrieve your missing files and this can slow down your server.

Relocating Multiple Jobs

In Job Overview mode, (filter and) select the jobs you want to relocate. Right-click and choose a
Relocate Job ticket:

Epp— e T eI
File Edit View Go Job Tools Advanced Help
= |88 |50 [1ob overview - | e »-
Views Jobs
£ Jobs Hama = [Description Customer Nama Due Date Order I ForWhichOperator
3 cot [Pe1255  banana
= Milestones = 1236 lemon Open
= Smaet Views Open in New Tab
W o 193 jobs B 1404-L74536_002  New flavour Cocos & 1404-174536 adam
= m’ms MNew lab... Cirl+AltsN
B 200 crented todsy Find Job... Cirl+Alts Shift+ O
'E Siill Heed Flates Today Mew Task '
[ 21 12 Jobo Relocate Job [0 Default
= T"'“;';ﬂ Remave Job. 3 FruitCo jobs Job name
Devices T
1fF Queus Monitar Delete View Data..
= Containers
& Access Paoints Manage Job Filters...

8.2. The Archive Job Task

54

Concept

The Archive Job task removes a job from the jobs database and exports the data in a form that enables
to restore the job later.

Typical for this task is that it exports the job metadata as well, these are the job setup parameters. This
metadata makes it possible to restore the job (back) later.

Note: The job's metadata is exported in a subfolder named 'config'.

Note: When you launch the Zip task on a job, the task only ZIP's the data inside the job folder, not the
job's metadata.

Note: When archiving (removing)a job, the tasks that were launched in that job will be deleted. If you
want to keep these tasks, use the Task History tool. This tool allows setting up rules that automatically
move those tasks to a separate database (before archiving the job).
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Task Options

5 New Task - ARC Standard R -

File Edit View Advanced

=i % Launch| = | Task Options Pricrity:| Normal - | Hold A

Settings for Step: Archive Job

[L_-_L Output in: | file://ROVMAEDEMO/ExamplelabContainer/Archived Job Data/ Browse []
File Name:| [Order 1D]_[Job Name] Beowse []

[¥] Generate ZIF file
[V Generate XML: |file://ROVMAEDEMO/ExamplelobContainer/Archive XML Info/[ |Browse | []
Apply XSLi Browse

Keep Jab and Job Folder (Export Job)

« Outputin: define where you want to write this archive data. For example some customers use a
3rd party backup/archive solution that scans specific network folders for new incoming data. This
system then archives that data online or writes it on a backup medium.

« File Name: define the name of the file in which all data will be stored. When you do not choose to
generate a ZIP file, this will be a folder with subfolders.

« Generate ZIP file: deselect this option if you want to move the job folder to the above location
without ZIP'ing all data.

« Generate XML: select this option to generate an XML file that describes this job. Such an XML
file can be useful for a 3rd party archive solution that for example uses it to build up its search
database.

« Apply XSL: select this option if you want to format the XML file using an XSL style sheet from a 3rd
party archive solution.

+ Keep Job and Job Folder (Export Job): deselect this option if you want to delete the job folder
once it is successfully archived.

Select this option if you still want to keep the job in the job database and also keep the job folder in
its original location. Here are some examples when to choose this:

» Touse this task as ajob backup tool.

« Toexchange that job with another Automation Engine. For example to send to a job to another
plant of your company (that also has Automation Engine) or to share the job with Esko Customer
Service.

Archiving Multiple Jobs

In Job Overview mode, right-click the selected jobs and choose your Archive Job ticket.

Here is an example of a smart way to archive multiple jobs. The filter lists all jobs that have their
milestone "Job Finished" confirmed this week:
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File Edit View Go Job Tools Advanced Help
= B ob Overview - | e P -
=] Virwe Search: |All| Order ID Name Project ID Customer Job Reference Hide Criteris | Dong | Sewve | -
£ Jabs Exsts = a milestone where =]
E ot Milessone name = iz Job finished ~ ==
E Gstanas Al = af the Following are trus =ll=
(=1 Smart Views "
5 EratCo abs Milestone state > is | | m m =
52 Jobs created today Milestone confirmed date = is this wesk ~ ==
L Jobs Finished this week  Jobs
L still Need Plates Teday  yama - Description Customer Hame  Dus Date order EorwhichOperater
(29 aill 12 jobs
=l Tools Open
1 Devices Open in New Tab
I e Pt News Job... Ctri+Alt+N
L conteiners = Eo
g Puinis ind Job... Ctrl+Alt=Shift+0
B customers New Task ' Archive Jab - ARC Standard
4 users Relocate Job " Zip- Default
Remove Jokb.. Manage Milestane ¢
Delete View Dat Warkflow L
L e
Sleve Niew Lae Relocate Job "
Manage Job Filters..
L Other...
3 jobs Sarver: ROVMAEDEMO  User: wde £ 6

Using the Archive Job Task in a Workflow
You can end a workflow by archiving the job that the workflow was launched in.
Here is an example:
o—> l=l- o= ([} 0= (] © o I = (5 .=}
- NG D« b=t agi g Ol g Lgciieg v/

Start Step & Repaat RIP QA check o Ready For Plate  Wait 2 weeks Ready for Archive Archn-a
NOT CONFIRMED

Notice these steps:

« After the plate making stage, the workflow waits for 2 weeks.
« |tthen sets the milestone "Ready for Archive" but without the option to confirm it. This triggers a
request for a user intervention (learn more about this option the Manage Milestone task).

«  When a user confirms this milestone, the workflow continues and archives the job.

8.3. The Restore Job Task

Concept

This task allows to restore jobs back to the Automation Engine job database that were previously
archived using the Archive Job task.

Note: When the Restore Job task is a step in a workflow, it will only have the error output pin.

Possible Input Types
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The input file for this task can be

a ZIP file created by the Archive Job task.

ajob folder created by the Archive Job task.

Important: The ZIP file or the folder need to be created by a version of Automation Engine that is
equal or lower than yours.

an XML file that refers to the location of a ZIP or folder created by the Archive Job task.
The root node of the XML needs to have an XML attribute named "Location". The value of this

attribute is the URL to the ZIP or archived job folder. Here is an example XML (it looks like the XML
generated by the Archive Task):

<?xml version="1.0" encoding="UTF-8"7?>
<Archive Location="file:/ faeserver01/Food/Archived Job Data/1237.zip"/>

Task Options

(3 Defauit - Restore Job _ FEErEET——)

File View Advanced

=)
i Output in:| [Job URL] Brawse | [1
£}
Job Name: | [Job Name] [1
Order 10: | [Order ID] [1
SubOrder 10: | [Sub Order ID] [1
Due Date: | Tomorrow ¥ at|5:00 PM -

| Delete archived data

V] Launch workfiow when the job is restored

| Workflow:  Sample Basic WFL Sehech
Please note that when the workflow is launched, the task will not wait for the

workflow to finish |

) | Show Steps ] ,Wl | cancel l |

Output in: Define where you want to place the restored job folder. Use [Job URL] when you want
to restore the job to its original location and with its original job folder name.

Note: When you restore to a server that has a different name (typically a new AE server), then avoid
using SmartNames that result in a value that contains that name of the old server. For example,
[Job URL] will try to restore to a path containing the name of the old server. Consider defining an
output path that also uses [Server], the SmartName for the name of the current server.

Job Name: Define the name of job once it is restored. Use [Job Name] when you want the job's
original name.

Order ID and SubOrder ID: Similar to the job name, define a new ID or use SmartNames to use the
ID's of the original job.
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« Due Date: Set the job's new due date.

- Delete archived data: Select this option if you want to delete the archive data after restoring the
job.

« You can choose to Launch a workflow when the job is restored. The advantage of this functionis
that the chosen workflow will be launched in the context of the restored job. This means that all the
used SmartNames will get their value from that job.

Important: If the Restore Job task itself is part of a workflow, the workflow that is chosen in this
task will start immediately, as a separate workflow. It will not wait for the workflow that contains the
Restore Job task to finish.

Note: This functionality is used when using 3rd party (hotfolder based) archiving solutions.

8.4. The Check Job Parameters (Classic) Task

This task serves to check if your file matches specific parameters as defined in your job setup. You can
also use it to automatically correct the file according those parameters.

Important: This task only supports Normalized PDF(PLA) files.

Note: For the task to function properly, the file should be part of an Automation Engine Job.

8 ] 5= 8] o ()

i3 Default - Check Job Parameters

File View Advanced

e )
,?EJ Qutput in: Browie | []
File Name: growsa | []
A
Check for mismatches:
Category | Action i
v | Barcode Auto Correct
V| Inks AutoComect e ) Y

= 0 0 el
Auta Correct (Strict Checking)
Stop with Error

i | Show Steps | l Save l Cancal |

Category Barcode
For barcode settings, you can select:
» Auto Correct when you want to correct the file with what is specified in the job's Barcodes tab .

For example, your Normalized PDF includes an Esko barcode of type EAN-13 and code
123456789012, and your job parameters specify an EAN-13 with code 5449000050205, then this
task will automatically correct the barcode number in the PDF to 5449000050205.

« Stop with Error when you want the task to stop with an error if the barcode in the job's Barcodes tab
does not match the barcode in the file.
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Note: This task only checks barcodes created in Esko PackEdge or by using Esko's barcode plug-in for

Adobe lllustrator (DeskPack). If the task does not find such a barcode, the task will end in a warning.

Note: You cannot use this task to check and auto correct barcodes in normalized PDFs generated by

ArtPro.

Category Inks

Forinks, you can select:

« Auto Correct when you want the task to correct attributes of the file's inks according what is

specified in the job's Inks tab.

« Auto Correct (Strict Checking): Same as ‘Auto Correct’ but now also the order of the inks is
corrected (according the job's ink parameters).

In this strict setting, the task will finish with an error if it finds unexpected inks (inks that are in the

file, but not defined in the job parameters) and with a warning if it finds missing inks (inks that are
not in the file but defined in the job parameters).

« Stop with Error when you want the task to stop with an error if the job's ink parameters are different

than those in the file.

Table: Some example situations when checking inks

Missing ink (ink specified in Job Parameters but
not in file)

Always results in Warning

Wrong sequence of inks

Results in Error in case of strict checking,
otherwise: no message

Unexpected ink (ink in file which is not in Job
Parameters)

Resultsin Error in case of strict checking,
otherwise: no message

8.5. The Remove Job Task

The Remove Job task serves to remove one or multiple jobs.

Tip: Learn more about what happens when jobs are removed in About Removing Jobs on page 50.

i1 Edit Ticket of Remove Job

)

L@:

a

Delete files and folders

@ | saveas.. | 3%~

' 0K | Cancel |
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Using the Remove Job Task in a Workflow

This task needs a job as input. This is why, in a workflow, you typically use the workflow control Select
Job in front of this task.

Having Jobs Removed by an External System
Any task can be launched by an external system. In workflows where jobs are created automatically
through integration with an external system, that same system can also decide when to remove jobs.

For example a business system triggers the Remove Job task right after it invoiced the job. Learn more
in Integrating with External Systems.

Only Removing the Job from the Database or also Removing the Files?

You can choose to also Delete the files and folders. This will delete the whole job folder.

Note: In a workflow, when this option is active, the Remove Job task step does not have an output pin
and so represents an end point for that workflow.

Note: When the files and folders were not deleted, you can later still recreate the removed job with the
same job settings as before. To do this, select the ex-job folder and choose New Job or launch the task
Restore Job.

What about the Job's Tasks?

As usual, when a job is removed, the Task Cleanup Rules are applied. These rules decide which tasks
move to the Task History and which ones are deleted. After applying these task cleanup rules (if any),
any remaining tasks of this job are deleted.
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9. Automated Creation of Jobs

Most of the job setup parameters originate in another system, often the order entry part of the
business system. It could also be a web portal where job specifications were first entered.

When someone already entered this data manually, we advise to not re-enter that data. We therefore
strongly advise to get your jobs created automatically.

The chapter Integrating with External Systems explains how this can be done. It describes the many
available techniques and also offers exercises.

Here is a summary of how jobs can be created automatically:

« bythe Create Job task that, as part of a workflow, picks up the job setup parameters via
SmartNames or from an external (XML) file(s).

« byan Access Point that interacts with the external system and launches a workflow that uses the
found information in the Create Job task.

« viaJDF/JMF commands from an external system, sent directly to Automation Engine's JDF channel.
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